CAUTION: TO REDUCE THE RISK OF ELECTRIC SHOCK, DO NOT REMOVE COVER (OR BACK). NO USER-SERVICEABLE PARTS INSIDE. REFER SERVICING TO QUALIFIED SERVICE PERSONNEL.

The lightning flash with arrowhead symbol, within equilateral triangle, is intended to alert the user to the presence of uninsulated “dangerous voltage” within the product’s enclosure that may be of sufficient magnitude to constitute a risk of electric shock to persons.

The exclamation point within an equilateral triangle is intended to alert the user to the presence of important operating and maintenance (servicing) instructions in the literature accompanying the appliance.

WARNING: TO PREVENT FIRE OR SHOCK HAZARD, DO NOT EXPOSE THIS APPLIANCE TO RAIN OR MOISTURE.

For the customers in Europe

WARNING
This is a Class A product. In a domestic environment, this product may cause radio interference in which case the user may be required to take adequate measures.

Pour les utilisateurs en Europe

AVERTISSEMENT
Il s’agit d’un produit de Classe A. Dans un environnement domestique, cet appareil peut provoquer des interférences radio, dans ce cas l’utilisateur peut être amené à prendre des mesures appropriées.

Für Kunden in Europa

Warnung
Dies ist eine Einrichtung, welche die Funk-Entstörung nach Klasse A besitzt. Diese Einrichtung kann im Wohnbereich Funkstörungen versursachen; in diesem Fall kann vom Betreiber verlang werden, angemessene Maßnahmen durchzuführen und dafür aufzukommen.

TO THE USER

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction manual, may cause harmful interference to radio communications.

Operation of this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

CAUTION
Changes or modifications to this equipment not expressly approved by TEAC CORPORATION for compliance could void the user’s authority to operate this equipment.

CE Marking Information
a) Applicable electromagnetic environment: E4
b) Peak inrush current: 8.0 A

In North America use only on 120V supply.
1. Read these instructions.
2. Keep these instructions.
3. Heed all warnings.
4. Follow all instructions.
5. Do not use this apparatus near water.
6. Clean only with dry cloth.
7. Do not block any ventilation openings. Install in accordance with the manufacturer’s instructions.
8. Do not install near any heat sources such as radiators, heat registers, stoves, or other apparatus (including amplifiers) that produce heat.
9. Do not defeat the safety purpose of the polarized or grounding-type plug. A polarized plug has two blades with one wider than the other. A grounding type plug has two blades and a third grounding prong. The wide blade or the third prong are provided for your safety. If the provided plug does not fit into your outlet, consult an electrician for replacement of the obsolete outlet.
10. Protect the power cord from being walked on or pinched particularly at plugs, convenience receptacles, and the point where they exit from the apparatus.
11. Only use attachments/accessories specified by the manufacturer.
12. Use only with the cart, stand, tripod, bracket, or table specified by the manufacturer, or sold with the apparatus. When a cart is used, use caution when moving the cart/apparatus combination to avoid injury from tip-over.
13. Unplug this apparatus during lightning storms or when unused for long periods of time.
14. Refer all servicing to qualified service personnel. Servicing is required when the apparatus has been damaged in any way, such as power-supply cord or plug is damaged, liquid has been spilled or objects have fallen into the apparatus, the apparatus has been exposed to rain or moisture, does not operate normally, or has been dropped.

- Do not expose this apparatus to dripping or splashes.
- Do not place any objects filled with liquids, such as vases, on the apparatus.
- Do not install this apparatus in a confined space such as a book case or similar unit.
- The apparatus should be located close enough to the AC outlet so that you can easily grasp the power cord plug at any time.
- An apparatus with Class I construction shall be connected to an AC outlet with a protective grounding connection.
- Batteries (battery pack or batteries installed) should not be exposed to excessive heat such as sunshine, fire or the like.
- Excessive sound pressure from earphones and headphones can cause hearing loss.
- The apparatus draws nominal non-operating power from the AC outlet with its STANDBY/ON in the Standby position.
Rack-mounting the Unit

Use the supplied rack-mounting kit to mount the unit in a standard 19-inch rack, as shown below. Remove the feet of the unit before mounting.

NOTE

- Leave 1U of space above the unit for ventilation.
- Allow at least 10 cm (4 in) at the rear of the unit for ventilation.
Contents

1 – Introduction ....................... 6
  Features ..................................... 6
  Supplied accessories .................. 6
  Manual conventions ................... 6
  Precautions for placement and use ... 6
  Beware of condensation .............. 7

2 – Features of the US-1641 .......... 8
  Front Panel ............................... 8
  Rear Panel ............................... 9

3 – Installation ......................... 10
  System requirements ................... 10
    Windows ................................... 10
    Mac OS X ................................ 10
  Installing the drivers .................. 11
    Installing the drivers for Windows ... 11
    Installing the drivers for Mac OS X ... 12
    Updating the firmware for the US-1641.. 13
  Installing Cubase LE 4 .................. 14
  Settings on your computer ............ 16

4 – Control Panel settings .......... 17
  Overview ................................ 17
  Driver settings ......................... 17
    Audio Performance (Windows PC case) .. 17
    Sample Clock Source .................. 17
    Digital Output Format .................. 17
    Digital Output Channels ............... 17

5 – Connections ....................... 18
  USB connections .......................... 18
  Audio connections ..................... 18
  MIDI connections ...................... 19

6 – Recording with Cubase LE 4 ... 20
  Input setting ............................. 20
  Recording ............................... 21
  Mixdown ................................. 22

7 – Troubleshooting ................... 23

8 – Specifications ...................... 24
  Inputs and outputs ..................... 24
  General specifications ................. 25
  Audio performance ..................... 26
  Host computer compatibility .......... 26
  Dimensions ............................. 27
1 – Introduction

Thank you very much for purchasing the TASCAM US-1641 16x4 96 kHz/24 bit USB2.0 Audio/MIDI interface. Please read this owner’s manual carefully before using the unit in order to maximize your use of all its features. We hope that you will enjoy using this product, for many years to come.

• If you are uncertain how to perform the basic computer operations explained in this manual, please refer to the owner’s manual that came with your computer.
• For information on the operation of Digital Audio Workstation (DAW) software, please refer to the owner’s manual for the corresponding DAW.

TASCAM accepts no responsibility for the loss of any data that may arise from your use or inability to use this product to record onto MIDI equipment in your system or onto storage devices such as hard disks.

The US-1641 is a USB-based audio interface designed for use with Digital Audio Workstation (DAW) software, such as Cubase LE 4. It provides abundant analog and digital inputs and outputs, and 16-channel MIDI inputs and outputs. It is the ideal companion to any computer-based digital recording setup.

Features

• 24-bit/96 kHz audio interface
• Analog inputs (1-14) and digital inputs (L & R) can be used simultaneously, providing 16 audio inputs for your computer via USB
• Eight XLR mic inputs (balanced), two line/guitar inputs (balanced/unbalanced), and four line inputs (balanced)
• Stereo digital input jack (S/PDIF) and stereo digital output jack (selectable between S/PDIF and AES/EBU)
• Balanced stereo line output and headphone output
• MIDI IN/OUT
• Direct Monitor function allows zero-latency monitoring of the input

Supplied accessories

In addition to this manual, the following accessories are supplied.

• USB cable ................................................................. 1
• CD-ROM (containing drivers and manuals) ................... 1
• DVD-ROM (Cubase LE 4) ............................................. 1
• CD-ROM (TASCAM Continuous Velocity Piano) ......... 1
• Warranty card .......................................................... 1

Please contact your TASCAM supplier if any of these accessories are missing.

NOTE

We recommend that you keep the original box and packing materials for transportation of this unit.

Manual conventions

In this manual, we use the following conventions:

• Controls and keys on the US-1641 are written like this: MENU.
• We use the term “key” to describe the push-button controls on the US-1641.
• This typeface is used to designate on-screen controllers or buttons: Cancel
• Except above, this typeface is used to designate any text displayed by the software: New project

Precautions for placement and use

The US-1641 may be used in most areas, but to maintain top performance, and prolong operating life, observe the following notes, precautions and environmental conditions:

• Avoid exposing it to extremes of temperature and humidity and avoid mechanical shocks and vibration.
• Keep the unit away from strong magnetic fields (TV sets, computer monitors, large electric motors, etc.).
• The nominal temperature should be between 5°C and 35°C (41°F and 95°F).
• Relative humidity should be 30 to 90 percent.
• As the unit may become hot during operation, always leave sufficient space above the unit for ventilation. Do not install this unit in a confined space such as a bookcase, and do not put anything on top of the unit.
• Avoid installing this unit on top of any heat-generating electrical device such as a power amplifier.
• The voltage supplied to the unit should match the voltage as printed on the rear panel. If you are in any doubt regarding this matter, consult an electrician.
Beware of condensation

If the unit is moved from a cold to a warm place, or used after a sudden temperature change, there is a danger of condensation; vapor in the air could condense on the internal mechanism, making correct operation impossible. To prevent this, or if this occurs, let the player sit for one or two hours at the new room temperature before using.
Important Safety Precautions

TASCAM US-1641

2 – Features of the US-1641

Front Panel

1. **POWER switch and indicator**
   - Turns the power to the unit on or off. The POWER indicator lights up red when the power is on.

2. **USB indicator**
   - Lights up green to indicate a valid USB connection to the host computer.

3. **PHANTOM [1-4/5-8] switches**
   - Turn on the +48V phantom power supplied to the MIC IN [1-8] jacks.
   - Each switch turns on the phantom power for four input channels as a group. The phantom power is on when the switches are pushed in.
   - **CAUTION**
     - Turn this switch on only if you are using condenser microphones that require phantom power.
     - Do not connect or disconnect microphones from the US-1641 while phantom power is on.
     - Never supply phantom power to unbalanced dynamic microphones.
     - Some ribbon microphones can be damaged by phantom power. If you are not sure about your ribbon microphone, do not supply phantom power to the ribbon microphone.

4. **MIC IN [1-8] jacks**
   - These are XLR balanced analog mic input jacks. Use the Gain knobs to adjust the input gain level.
   - The wiring is as follows:
     - pin 1 = ground, pin 2 = hot, pin 3 = cold.

5. **LINE IN/GUITAR [9/10] jacks and select switches**
   - These stereo 1/4” phone jacks function as unbalanced guitar input jacks when the select switches are set to the GUITAR position, and function as balanced line input jacks when the switches are set to the LINE IN position.
   - (The wiring is as follows: sleeve = ground, tip = hot, ring = cold.) Use the Gain knobs to adjust the input gain level.

6. **Gain knobs and indicators [1-10]**
   - Adjust the gain level for Inputs 1-10 individually. The adjustable range is from –2dBu to –58dBu for Mic Inputs 1-8, and from +4dBu to +42dBu for Line Inputs 9-10. The Gain indicators will light green when a signal at a certain level (–30dBFS) or higher is present. However, if the signal level exceeds –2dBFS, the indicators will light red.

7. **MONITOR knob**
   - Adjusts the level of signals output from the MONITOR OUTPUTS [L/R] jacks on the rear panel.

8. **MIX knob**
   - Controls the balance of the signal sources being output from the MONITOR OUTPUTS [L/R] jacks and the PHONES jack. With this knob turned to the far left, the US-1641 will output the signal input from the MIC IN [1-8] jacks and LINE IN [9-14] jacks. With this knob turned to the far right, the US-1641 will output the signal received from the computer via USB.

9. **PHONES jack and PHONES LEVEL knob**
   - This stereo 1/4” headphone jack outputs the same signal that is output from the MONITOR OUTPUTS [L/R] jacks. The PHONES LEVEL knob controls the output level of the PHONES jack.
Rear Panel

10 **USB connector** Use a USB cable to connect this to the host computer. (Please note that this connector supports only USB 2.0 connection.)

11 **DIGITAL IN jack** This is an RCA connector that inputs a stereo S/PDIF digital signal.

12 **DIGITAL OUT jack** This is an RCA connector that outputs a stereo digital signal. Signals output from the LINE OUT [1/2] or [3/4] jacks can be output digitally from this jack (as set in the Control Panel). You can also select S/PDIF or AES/EBU as the digital signal format in the Control Panel.

13 **MIDI OUT connector** Transmits MIDI messages received from the computer.

14 **MIDI IN connector** Receives MIDI messages. The received MIDI messages will be transmitted to the computer.

53 **INPUTS [11-14] jacks and LEVEL switches** These are TRS 1/4” phone, balanced line input jacks. Use the LEVEL switches to set the nominal level to –10dBV or +4dBu.

**NOTE**
*You cannot adjust the gain level for these inputs.*

64 **LINE OUT [1-4] jacks** These are stereo TRS 1/4” phone, balanced line output jacks (sleeve = ground, tip = hot, ring = cold). The nominal output level is +4dBu. These jacks output signals received from the computer. Use DAW software to switch between LINE OUT [1/2] and LINE OUT [3/4].

65 **MONITOR OUTPUTS [L/R] jacks** These are stereo TRS 1/4” phone, balanced output jacks (sleeve = ground, tip = hot, ring = cold). These jacks enable you to monitor monaural mix input (1-14) signals and/or output signals received from the computer. Use the MONITOR knob on the front panel to adjust the output level.

66 **AC IN connector** Connect the supplied power cable to this connector and an AC outlet.
3 – Installation

System requirements

Windows

Supported operating system:
32-bit Windows XP SP2 or 32-bit Vista

Recommended system:
• CPU: Pentium4 or Athlon 1.4 GHz or faster (or equivalent processor)
• RAM: 512 MB or more memory
• HDD: 1 GB or more free space
• USB 2.0 port
• DVD-ROM drive to install Cubase LE 4
• Internet connection to activate Cubase LE 4

These requirements must be satisfied if you plan to use Cubase LE 4 (bundled with the US-1641). If you are planning to use other application software, please consult its technical documentation for operating requirements specific to that software.

Mac OS X

Supported operating system:
Mac OS X version 10.4 or later

Recommended system:
• CPU: Power PC G4 1GHz or higher, Core Solo 1.5GHz or higher
• RAM: 512 MB
• HDD: 1 GB or more free space
• USB 2.0 port
• Audio device that supports Core Audio
• DVD-ROM drive to install Cubase LE 4
• Internet connection to activate Cubase LE 4

For Macintosh systems as well, additional memory and a faster hard disk drive will facilitate smoother and easier operation of digital audio application software.

NOTE
The number of available audio tracks will depend on the speed of your hard disk. A faster hard disk will facilitate smoother and easier operation.

USB1.1 is not supported.

TASCAM recommends that you use a system with at least 512 MB of memory. However, additional memory will enhance the operation of digital audio application software.

This product has been tested for use with typical computers that meet the operating requirements listed above. However, the test results do not guarantee that the product will operate properly with every computer that meets these requirements. Please be aware that even under similar conditions, processing capabilities may vary depending on the particular design and specifications of the computer and the operating environment.
Installing the drivers

Before you can use the US-1641, you must install the appropriate drivers on your computer. As described below, this is a simple process that uses the CD-ROM included with the US-1641.

Drivers are updated from time to time. You can download the latest version of the drivers from the TASCAM website <http://www.tascam.com/>. Do not connect the US-1641 to your computer before you install the drivers.

安装驱动程序

请确保在您使用US-1641之前已安装适当的驱动程序到您的计算机上。如下面描述的那样，这是一个简单的过程，使用CD-ROM包含的驱动程序。

驱动程序不时进行更新。您可以从TASCAM网站下载最新版本的驱动程序 <http://www.tascam.com/>。请不要在安装驱动程序之前将US-1641连接到计算机上。

安装驱动程序的步骤

1. 确保US-1641没有连接到您的计算机上。
2. 将包含的驱动程序安装CD-ROM插入到您的计算机的CD-ROM驱动器中。
3. 当显示语言选择屏幕（下图）时，选择您想使用的语言，然后点击OK按钮。
4. 当屏幕上出现安装US-1641驱动程序，选择您想使用的语言，然后点击OK按钮。

CAUTION

Handle the enclosed CD-ROM with care. If the disc becomes scratched or dirty, your computer may be unable to read it and you may be unable to install the software.

If the disc becomes unreadable, you can request a replacement disc for a fee.

WARNING

Never attempt to play the enclosed CD-ROM in an audio CD player. The resulting noise could damage your speakers or your hearing.
6 Read the contents of the License Agreement, then select I accept the agreement if you agree to the terms. Click the Install button to start installation.

7 When the screen below appears, use the supplied USB cable to connect the US-1641 to the computer.

8 When the screen below appears, unplug the connecting USB cable from the US-1641 or the computer.

9 When the screen below appears, reconnect the US-1641 to the computer with the USB cable.

10 When the screen below appears, the installation is complete. Click the Reboot now button to restart the computer.

11 After the computer has restarted, select Start > Settings > Control Panel, then click TASCAM US-1641 Control Panel to open the US-1641 Control Panel. If the driver version, device name and other data appear to be correct, the installation was successful.

---

Installing the drivers for Mac OS X

1 Insert the included driver installation CD-ROM into your computer’s DVD-ROM drive, then double-click US-1641 Drivers.mpkg on the CD-ROM to start the installer.

2 Follow the instructions on screen.

3 Restart the computer, then use the USB cable to connect the US-1641 to the computer.
Updating the firmware for the US-1641

TASCAM may release updates for the software that runs on the microchip inside the US-1641. This is commonly called “firmware”. When your US-1641 is plugged into the computer, the US-1641 Control Panel shows what firmware version the unit is currently running. Visit TASCAM’s website (http://www.tascam.com) to see if a newer version of the firmware is available. If so, you can download a firmware updater program for you computer that will update your US-1641’s firmware.

Preparation Step 1:
Install the latest driver on your PC or Mac computer.

Preparation Step 2:
Connect the US-1641 (for which firmware will be updated) to the computer via a USB cable.

* The firmware updater varies with the firmware version of the unit.

For PC (Windows XP) users
1 Connect the US-1641 to the computer via a USB cable.
2 Run the firmware updater file (for PC) for the version to which you wish to update.
The system displays the following screen:

3 Click the write firmware button.

4 When the update process is complete, the system displays the following screen:

![Update successful](image)

5 Disconnect the USB cable from the US-1641.
The system displays the following screen:

![US-1641 Firmware Updater 1.00](image)

6 Click the Exit button to complete the update operation.

For Mac (OS X) users
1 Connect the US-1641 to the computer via a USB cable.
2 Run the firmware updater file (for Mac) for the version to which you wish to update.
3 Follow the steps for Windows PCs as described above. The screens displayed may appear slightly different from those shown above, but their content is essentially the same.
Installing Cubase LE 4

1. Insert the Cubase LE 4 DVD-ROM into the DVD-ROM drive on your computer.

   The system displays the language selection screen (below). Select the language you prefer.

   If this language screen does not appear automatically, run the Setup.exe program in the \Cubase LE 4 for Windows directory on the DVD-ROM.

2. Click the Install button.

3. The system displays the License Agreement for end users. Read the contents, then select I accept the terms in the License Agreement if you agree to the terms. Click the Next button.

4. The system displays the installation destination screen. Browse and specify the destination for installation, then click the Next button.

5. The system displays a screen indicating that it is ready to install the application. Click the Install button.


7. The system displays the Syncro Soft Welcome screen. Click the Next button to start the installation.
8. The system displays the License Agreement for end users. Read the contents, then select I accept the license agreement if you agree to the terms. Click the Next button.

9. The system displays a screen indicating that the Syncro Soft installation is complete. Click the Finish button to finish the installation procedure.

**NOTE**

When you start Cubase LE 4 for the first time, you will be asked to register the software on-line. If you do not register the software, you will be unable to use it beyond 30 days after you install the program. TASCAM recommends that you register the software at your earliest convenience.
Settings on your computer

Here are a few basic points to help you set up your computer for best performance with audio applications.

- Do not run other applications. You will probably use your computer for applications other than audio, but TASCAM recommends that you avoid running other applications at the same time you are running audio programs. Processing digital audio places a considerable load on your computer. This means that if you are running other applications (especially graphics or Internet tools) at the same time as your audio application, processing may not be fast enough.

- Certain devices such as network cards or WinModems can cause conflicts with USB operation. If you experience such a conflict, you can use the Device Manager to temporarily disable the offending device.

You can also improve the audio processing capability or increase the number of recording and playback tracks on your computer by upgrading or expanding the computer hardware.
# Overview

The US-1641 Control Panel enables you to control various features of the US-1641. It also reports the status of the driver and the currently connected unit. In Windows XP, you can access US-1641 Control Panel shortcut from the following:

- Start menu
- Window’s Control Panel
- All Programs > TASCAM > US-1641 Control Panel

In Mac OS X, US-1641 Control Panel is located in the Application folder. Audio MIDI settings, which is used for audio and MIDI settings, is located in the Utility folder in the Application folder.

The US-1641 Control Panel is divided into two sections:

## Status section

This section indicates the current status of the driver and the connected hardware. You cannot edit the settings in this section.

## Setting section

This section enables you to control various settings of the US-1641.

## Driver settings

### Audio Performance (Windows PC case)

The US-1641 driver temporarily stores input and output audio samples in buffers.

The Audio Performance setting enables you to adjust the buffer size to five levels. The Lowest Latency setting is the minimum buffer size, and the Highest Latency setting is the maximum buffer size.

A smaller buffer size will reduce the audio signal delay when you monitor the input signal, but will require your computer to perform the processing faster. If the processing does not occur in time (e.g., if the computer is performing other system operations), you may notice clicks, pops, or dropouts in the audio signal.

A larger buffer size will provide more stable operation and more safety against such problems caused by other system activities, but will produce greater delay in monitoring signals.

Select the buffer size that works best for your system.

For Mac computer users:

Mac’s control panel does not have Audio Performance on it. Instead of Audio Performance, each DAW has audio buffer setting which is based on sample step. That works as the same as Audio Performance.

### Sample Clock Source

You can set the clock source to Automatic or Internal.

**Automatic (default):** If a signal is being input to the DIGITAL IN jack, its clock will be used. If no signal is being input to the DIGITAL IN jack, the US-1641’s internal clock will be used.

**Internal:** The US-1641’s internal clock will always be used.

### Digital Output Format

This setting enables you to choose either AES/EBU or S/PDIF as the digital output format.

### Digital Output Channels

The DIGITAL OUT jack outputs signals from either Line out 1 and 2 or Line out 3 and 4. This setting enables you to select one of these output channel pairs.
USB connections

Using the included cable, connect the US-1641 to your computer as shown in the illustration.

**NOTE**

Some USB devices access the USB bus frequently. To avoid dropouts and clicks in the audio signal, do not connect other USB devices to the USB bus used by the US-1641.

USB keyboards and mouse are exceptions to this, and will probably not cause problems.

Audio connections

Connect the output signal of your mic, guitar, keyboard, or other audio device to the US-1641, which will convert the signal into digital audio and send it via USB to your computer. Connect the output of the US-1641 to your speakers (via an amp) or headphones, so you will be able to monitor the audio signals coming into the US-1641 or signals being output from your computer.

**Mic**

Connect your microphones to the MIC IN [1-8] jacks (XLR). If you are using a condenser microphone that requires phantom power, turn on the phantom power.

**NOTE**

You can use more than eight microphones by connecting them via an external mic pre-amp. In this case, connect the output of the mic pre-amp to the LINE IN [11-14] jacks on the rear panel.

**Guitar**

Connect your electric guitar and base guitar to the LINE IN/GUITAR [9-10] jacks and set the GUITAR-LINE IN switch to GUITAR.
Keyboard/drum machine/sound module/CD player, etc. (analog connection)
Connect the analog audio output of these devices to the LINE IN/GUITAR [9-10] jacks or INPUTS [11-14] jacks.
If you use the LINE IN/GUITAR [9-10] jacks, set the GUITAR-LINE IN switch to LINE IN.

**NOTE**
*If you use the LINE IN/GUITAR [9-10] jacks, you can adjust the input gain levels continuously from –6dBv to –52dBv. If you use the INPUTS [11-14] jacks, you can switch the nominal level between –10dBv and +4dBu.*

Sound module/CD players, etc. (digital connection)
Connect the digital audio output of these devices to the DIGITAL IN jack.

**NOTE**
The US-1641 DIGITAL OUT jack outputs either S/PDIF or AES/EBU signals (selectable in the US-1641 Control Panel). On the other hand, you can input S/PDIF signals to the DIGITAL IN jack.

Headphones
Connect a set of stereo headphones to the PHONES jack (1/4” stereo phone jack).

Powered speakers/audio system
Connect powered monitoring speakers or audio system to the MONITOR OUTPUTS [L/R] jacks.

MIDI connections
Connect your sound module, keyboard/synthesizer, drum machine, or other MIDI device to the US-1641 as shown in the illustration on page 17.

The US-1641 receives MIDI signal at the MIDI IN connector, then transmits it to the connected computer. Also, the US-1641 receives MIDI signal from the computer, then transmits it from the MIDI OUT connector. In this way, you can use the MIDI IN/MIDI OUT connectors to transmit and receive MTC (MIDI Time Code). This allows the MTC-compatible MTR (Multi Track Recorder) of your DAW (Digital Audio Workstation) computer application to synchronize with your MIDI equipment.
This chapter explains basic operations for using the US-1641 with Cubase LE 4. This explanation is not intended to replace the user’s manual for Cubase LE 4. For more information on Cubase LE 4, please refer to the Cubase LE 4 user’s manual.

### Input setting

1. **Start** Cubase LE 4. From the **Devices** menu, choose **Device Setup**. The system displays the **Device Setup** window.

   ![Device Setup Window](image)

   In the **VST Audio System** section in the right side of the **Device Setup** window, select **US1641** for **ASIO Driver**.

2. From the **Devices** menu, choose **VST Connection**. The system displays the **VST Connections** window, which features two tabs: **Input** and **Output**.

   ![VST Connections Window](image)

   Select the **Inputs** tab, then set the input bus. When you set the input bus, a device port is automatically selected. If necessary, you can change the device port. The device port pull-down list indicates all available input ports for the US-1641.

3. Select the **Outputs** tab, then set the output bus.

   ![VST Connections - Outputs](image)

   When you set the output bus, a device port is automatically selected. If necessary, you can change the device port. The device port pull-down list indicates all available output ports for the US-1641.

4. From the **File** menu, choose **New Project**.

   ![New Project Window](image)

   The system displays a window that enables you to select a template for your new project. Select the desired template and press the **OK** button. The system displays the Select directly window. Specify the directory in which you wish to save the project, then click the **OK** button. The new project will be created.

   **NOTE**

   If you have selected an Empty template, add audio tracks to the project by selecting Add Tracks from the Project menu.

You are now ready to begin recording.
Recording

1. Click the Edit Channel Settings button for the track you want to record to open the Channel Setting window. Then, specify the desired input bus in the Input field located in the upper-right corner.

2. Click the REC FUNCTION button to turn it on (the button indicator will light).

3. Press the (REC) button in the transport section to start recording.

4. When you finish recording, press the (STOP) button, then click the REC FUNCTION button to turn it off (the button indicator will turn off). Rewind if necessary.

5. Repeat steps 1, 2, and 3 to overdub additional tracks.
Mixdown

1. Move the left and right locators to specify the region that you want to mix down.

2. From the File menu, choose Export > Audio Mixdown.

3. In the Export Audio Mixdown dialog box, make the desired settings, then press the Export button.
This chapter answers frequently asked questions related to recording with Cubase LE 4.

Q1. I think I have configured the input settings properly, but I see no activity on the audio track's meter.
A1. Make sure that the Monitor button of the track is enabled.

Q2. I would like to record two channels simultaneously in stereo.
A2. Before you record, choose Stereo track(s) or add Audio track(s) as Stereo. In this case, the track input is indicated as Stereo in or something similar.

Q3. I am trying to use the EQ, but it does not seem to do anything.
A3. Check the VST channel setting or other settings to make sure that EQ bypass is disabled.

Q4. I tried to mix down a three-minute song, but could mix only ten seconds.
A4. Make sure that the region specified by the left and right locators is set to three minutes or longer.

Q5. I cannot set the locator region to more than ten minutes.
A5. The default setting is ten minutes. From the Project menu, choose Project Setup and then change the Length field.

Q6. I burned a CD using the WAV file I mixed down, but the speed is obviously different.
A6. Could the sampling rate of your project be set to 48 kHz? If your ultimate objective is to create a CD, TASCAM recommends that the sampling rate be set to 44.1 kHz from the beginning.

To specify the sampling rate, choose Project Settings from the Project menu, then set the sampling rate to 44.100 kHz.

Q7. I have connected an audio source to the US-1641, but cannot hear anything.
A7. Make sure that the input level is raised appropriately. When a signal is being input, the Gain indicator will light up green. Make sure that the monitor (or headphone) level is raised, and that the connections are correct.

Q8. The sound is distorted.
A8. Make sure that the signal is not overloading. If the signal is analog, the ideal level is when the Gain indicator lights up red occasionally.

Q9. I tried to change the sample rate in the Control Panel, but could not.
A9. If a valid signal is plugged into the US-1641’s digital input, and the Sample Clock Source menu has been set to Automatic, the US-1641 will always run at the sample rate received at its digital input. To run at a different sample rate while continuing to receive digital audio, you must change the sample rate of the device that is sending the digital signal. If you do not need to continue to receive digital audio, you can set the Sample Clock Source menu to Internal or simply unplug the cable connected to the digital input.
**Inputs and outputs**

### MIC IN [1-8] jacks (analog)

<table>
<thead>
<tr>
<th>Connector</th>
<th>XLR-3-31</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type and wiring</td>
<td>Balanced (1: ground, 2: hot, 3: cold)</td>
</tr>
<tr>
<td>Input impedance</td>
<td>2.2kΩ</td>
</tr>
<tr>
<td>Input level (with the Gain knobs set at maximum)</td>
<td>–58dBu</td>
</tr>
<tr>
<td>Input level (with the Gain knobs set at minimum)</td>
<td>–2dBu</td>
</tr>
<tr>
<td>Headroom</td>
<td>16dB</td>
</tr>
</tbody>
</table>

### LINE IN/GUITAR [9-10] jacks (analog)

[With the LINE IN-GUITAR switch set to LINE IN]

<table>
<thead>
<tr>
<th>Connector</th>
<th>1/4” phone jack</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type and wiring</td>
<td>Balanced (Tip: hot, Ring: cold, Sleeve: ground)</td>
</tr>
<tr>
<td>Input impedance</td>
<td>10kΩ</td>
</tr>
<tr>
<td>Nominal input level (with the Gain knobs set at maximum)</td>
<td>–42dBu</td>
</tr>
<tr>
<td>Nominal input level (with the Gain knobs set at minimum)</td>
<td>+4dBu</td>
</tr>
<tr>
<td>Headroom</td>
<td>16dB</td>
</tr>
</tbody>
</table>

[With the LINE IN-GUITAR switch set to GUITAR]

<table>
<thead>
<tr>
<th>Type</th>
<th>Unbalanced</th>
</tr>
</thead>
<tbody>
<tr>
<td>Input impedance</td>
<td>700kΩ</td>
</tr>
<tr>
<td>Nominal input level (with the Gain knobs set at maximum)</td>
<td>–52dBv</td>
</tr>
<tr>
<td>Nominal input level (with the Gain knobs set at minimum)</td>
<td>–6dBv</td>
</tr>
<tr>
<td>Headroom</td>
<td>6dB</td>
</tr>
</tbody>
</table>

### INPUTS [11-14] jacks (analog)

<table>
<thead>
<tr>
<th>Connector</th>
<th>1/4” phone jack</th>
</tr>
</thead>
<tbody>
<tr>
<td>Type and wiring</td>
<td>Balanced (Tip: hot, Ring: cold, Sleeve: ground)</td>
</tr>
<tr>
<td>Input impedance</td>
<td>10kΩ</td>
</tr>
<tr>
<td>Nominal input level (selectable with the LEVEL switch)</td>
<td>+4dBu or –10dBv</td>
</tr>
<tr>
<td>Headroom</td>
<td>16dB</td>
</tr>
</tbody>
</table>

### DIGITAL IN jack (digital)

<table>
<thead>
<tr>
<th>Connector</th>
<th>RCA pin jack</th>
</tr>
</thead>
<tbody>
<tr>
<td>Signal format</td>
<td>IEC958 Consumer (S/PDIF)</td>
</tr>
<tr>
<td>Level</td>
<td>0.5Vpp/75Ω</td>
</tr>
</tbody>
</table>
**8 – Specifications**

<table>
<thead>
<tr>
<th><strong>DIGITAL OUT jack (digital)</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector</td>
<td>RCA pin jack</td>
</tr>
<tr>
<td>Signal format</td>
<td>Selectable in the Control Panel between IEC958 Consumer (S/PDIF) and IEC958 Professional (AES/EBU)</td>
</tr>
<tr>
<td>Level</td>
<td>0.5Vpp/75Ω</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>LINE OUT [1-4] jacks (analog)</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector</td>
<td>1/4&quot; phone jack</td>
</tr>
<tr>
<td>Type and wiring</td>
<td>Balanced (Tip: hot, Ring: cold, Sleeve: ground)</td>
</tr>
<tr>
<td>Output impedance</td>
<td>100Ω</td>
</tr>
<tr>
<td>Nominal output level</td>
<td>+4dBu</td>
</tr>
<tr>
<td>Maximum output level</td>
<td>+20dBu</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>MONITOR OUTPUTS [L/R] jacks (analog)</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector</td>
<td>1/4&quot; phone jack</td>
</tr>
<tr>
<td>Type and wiring</td>
<td>Balanced (Tip: hot, Ring: cold, Sleeve: ground)</td>
</tr>
<tr>
<td>Output impedance</td>
<td>100Ω</td>
</tr>
<tr>
<td>Nominal output level</td>
<td>+4dBu</td>
</tr>
<tr>
<td>Maximum output level</td>
<td>+24dBu</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>PHONES jack (analog)</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector</td>
<td>1/4&quot; stereo phone jack (Tip: L, Ring: R, Sleeve: ground)</td>
</tr>
<tr>
<td>Maximum output level</td>
<td>50mW + 50mW (32Ω/1% distortion)</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>MIDI IN connector</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector</td>
<td>5-pin Din [Standard MIDI format]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>MIDI OUT connector</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector</td>
<td>5-pin Din [Standard MIDI format]</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th><strong>USB connector</strong></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Connector</td>
<td>USB Series B connector</td>
</tr>
<tr>
<td>Format</td>
<td>USB 2.0</td>
</tr>
</tbody>
</table>

**General specifications**

<table>
<thead>
<tr>
<th><strong>Sampling rate (internal clock)</strong></th>
<th>44.1kHz, 48kHz, 88.2kHz, 96kHz</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Sample width</strong></td>
<td>24-bit</td>
</tr>
<tr>
<td><strong>External dimensions (W x D x H)</strong></td>
<td>482.6 x 280 x 44 (mm) / 19 x 11.1 x 1.74 (in)</td>
</tr>
<tr>
<td><strong>Weight</strong></td>
<td>3.2kg / 7.1lb</td>
</tr>
<tr>
<td><strong>Power</strong></td>
<td>U.S.A./Canada 120V AC, 60Hz</td>
</tr>
<tr>
<td></td>
<td>U.K./Europe 230V AC, 50Hz</td>
</tr>
<tr>
<td></td>
<td>Australia 240V AC, 50Hz</td>
</tr>
<tr>
<td><strong>Power consumption</strong></td>
<td>10W</td>
</tr>
</tbody>
</table>
# 8 – Specifications

## Audio performance

### Delay

<table>
<thead>
<tr>
<th>ADC</th>
<th>DAC</th>
</tr>
</thead>
<tbody>
<tr>
<td>≤0.63ms (ADC), ≤0.44ms (DAC) (at Fs 44.1kHz)</td>
<td>≤0.29ms (ADC), ≤0.20ms (DAC) (at Fs 96kHz)</td>
</tr>
</tbody>
</table>

### Signal-to-noise ratio

[With MIX knob set to COMPUTER]

<table>
<thead>
<tr>
<th>Input/Output</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>MIC IN [1-8] -&gt; LINE OUT [1-4]</td>
<td>≤-60dBu (with Gain knob set to maximum)</td>
</tr>
<tr>
<td>INPUTS (11-14) -&gt; MONITOR OUT (L/R)</td>
<td>≤-70dBu (with MONITOR knob set to maximum)</td>
</tr>
</tbody>
</table>

[With MIX knob set to INPUT]

<table>
<thead>
<tr>
<th>Input/Output</th>
<th>Level</th>
</tr>
</thead>
<tbody>
<tr>
<td>All inputs -&gt; MONITOR OUT (L/R)</td>
<td>≤-60dBu (with Gain knobs and MONITOR knob set to maximum)</td>
</tr>
</tbody>
</table>

### Frequency response (LINE OUT, –10dBV)

<table>
<thead>
<tr>
<th>Rate</th>
<th>Range</th>
<th>Distortion</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>20Hz - 20kHz</td>
<td>+1/–1dB</td>
</tr>
<tr>
<td>High</td>
<td>20Hz - 40kHz</td>
<td>+1/–3dB</td>
</tr>
</tbody>
</table>

### Total harmonic distortion (20Hz - 20kHz)

≤0.01% (All outputs, minimum gain, maximum input level, excluding GUITAR IN)

### Crosstalk (1kHz)

90dB

## Host computer compatibility

### Operating system

<table>
<thead>
<tr>
<th>Operating System</th>
<th>Compatibility</th>
</tr>
</thead>
<tbody>
<tr>
<td>Windows</td>
<td>32-bit Windows XP SP2 or 32-bit Vista</td>
</tr>
<tr>
<td>Macintosh</td>
<td>Mac OS X version 10.4 or later</td>
</tr>
</tbody>
</table>

### Drivers

- WDM (KS), ASIO/ASIO2 and GSIF2 interface (Windows XP, Vista)
- Core Audio and MIDI interface (Macintosh OS X)

---

* Microsoft, Windows, and Windows XP are registered trademarks of Microsoft Corporation in the United States of America and in other countries.

* Athlon is a registered trademark of Advanced Micro Devices, Inc. in the United States of America.

* Pentium is a registered trademark of Intel Corporation in the United States of America.

* MIDI is a registered trademark of Association of Musical Electronics Industry (AMEI) and the MIDI Manufacturers Association (MMA).

* The name of companies and products described in this manual are trademarks or registered trademarks of the corresponding owners.
Dimensions

280.0 mm
482.6 mm
494.2 mm

1.4 mm
0.5 mm
1.0 mm
41.6 mm
44.0 mm